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Commercial Design Using Autodesk Revit Architecture

Lesson 3
Office Building: FLOOR PLAN (First Floor)::

In this lesson you will draw the first floor plan of an office building. The
office building will be further developed in subsequent chapters. It is
recommended that you spend adequate time on this lesson as later
lessons build on this one.

Project Overview

A program statement is created in the pre-design phase of a project.
Working with the client (or user group), the architect gathers as much
information as possible about the project before starting to design.

The information gathered includes:

e Rooms: What rooms are required?

e Size: How big the rooms need to be? (E.g., toilets for a
convention center are much bigger than for a
dentist’s office.)

e Adjacencies: This room needs to be next to that room. (E.g., the
public toilets need to be accessible from the public
lobby.)

With the project statement in hand, the architect can begin the design
process. Although modifications may (and will) need to be made to the
program statement, it is used as a goal to meet the client’s needs.

You will not have a program statement, per se, with this project.
However, the same information will be provided via step-by-step
instructions in this book.

Project overview:

You will model a three-story office building located in a rural setting.
Just to the north of the building site is a medium-sized lake. For the
sake of simplicity, the property is virtually flat.

The main entry and parking is from the south side of the building. You
enter the building into a three-story atrium. Levels 2 and 3 have guard
railings that look down into Level 1 in the atrium. The atrium is
enclosed on three sides by full height curtain wall (glass walls). See
the image on the front cover.



Commercial Design Using Autodesk Revit Architecture
__________________________________________________________________________________________________________|

This building is not meant to meet any particular building code. It is
strictly a tool to learn how to use Revit. Having said that, however,
there are several general comments as to how codes may impact a
particular part of the design.

The floor plans are mostly open office areas with a few smaller rooms
for toilets, private offices, work and break rooms, etc. These areas
have several “punched” window openings on the exterior walls
(punched as opposed to Ribbon windows).
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Figure 3-1.1 Level 1 floor plan sketch
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Figure 3-1.2 South elevation sketch
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Exterior Walls

You will begin the first floor plan by drawing the exterior walls. Like
many projects, early on you might not be certain what the exterior
walls are going to be. So, we will start out using the generic wall
styles. Then we will change them to a custom wall style (that you will
create) once we have decided what the wall construction is.

Adjust wall settings: %

1. Start a new project using the Default template, and then
select Wall from the Ribbon.

2. Make the following changes to the wall options in the Options
Bar (Figure 3-2.1):
e Wall style: Basic Wall: Generic — 12"
e Height: Unconnected
e Height: 36" 0”
e Location Line: Finish Face: Exterior

Home Insert Annotate Modify Massing 8 5ite Collaborate  View  Manage [EERCRUVEN
% g Basic Wa & & E -
= Generic - 12 oo
e Flement Change Element Type - f fent u}[g .
Properties ~ 9 P EE‘S -
Selection Element Draw
Place Wall Height: Unconr = 36" 0" Location Line! Einjsh Face: Ext - V| Chain Offset: 0" 0" R%
Projectl - Project browser 8 ‘ j
| L~ = e "---..._A—-u.:-l e e e A | gt

Figure 3-2.1 Ribbon and Options bar: Wall tool active

Draw the exterior walls:

3. Draw the walls shown in Figure 3-2.2. Make sure your
dimensions are correct. Use the Measure tool to verify your
dimensions.

NOTE: If you draw in a clockwise fashion, your walls will have the exterior
side of the wall correctly positioned. You can also use the spacebar to toggle
which side the exterior face is on.
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Figure 3-2.2 Exterior walls

Revit provides several predefined wall styles, from metal studs with

gypsum board to concrete block and brick cavity walls. However, you

will occasionally need a wall style that has not yet been predefined by

Revit. You will study this feature next.

First, you will take a quick look at a more complex wall type that Revit
provides so you can see how they are set up.

4. With the Wall tool selected, pick
the wall type: Basic Wall:
Exterior — Brick on CMU, from
the Element Type Selector drop-
down list. (See image to the
right.)

5. Click the Element Properties
button to the left of the Element
Type Selector.

6. You are now in the Instance
Properties dialog box. Click the
Edit Type... button (Figure 3-2.3).
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Proj
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Project] - Project browser
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Site.
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7. You should be in the Type Properties dialog box. Click the Edit
button next to the Structure parameter (Figure 3-2.4).
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Instance Properties
Family: [Syshem Family: Basic Wall '] Load...
Type: [Exbenor - Brick on CMU -

Instance Parameters - Control selected or to-be-created instance

] [ EdltT\fDe‘..%@

‘ .

Parameter Value
Constraints S
Location Line Finish Face: Exterior
Base Constraint Levell
Base Offset 0o
Base is Attached
Base Extension Distance 00"
Top Constraint Unconnected
Uncennected Height 36' 0"

Top Offset

m

Top is Attached

Top Extension Distance

Room Bounding

Related to Mass

Structural

Structural Usage

Non-bearing

Dimensions

Area

23

Volume

Identity Data

Comments

WAoo

[ ok

Cancel

Figure 3-2.3 Instance Properties

8.

Office Building: FLOOR PLAN (First Floor)

[

Type Properties
Family: [Sysbern Family: Basic Wall 'I Load...
Type: [Exherlor -Brick on CMU A ] [ Duplicate... ]

Type Parameters

Rename. ..

Parameter Value |:
Construction R
Structure Edit...

Wrapping at Inserts Do not wrap E%
Wrapping at Ends None

Width 17102

Function Exterior

Coarse Scale Fill Pattern

mn

Coarse Scale Fill Color

Identity Data
Keynote

»

Model

Manufacturer

Type Comments

URL

Description

Assembly Description

Ext. Wall - Brick Composite

Assembly Code

B2010156

Type Mark

[ << Preview ]

Cancel Apply

Figure 3-2.4 Type Properties

Finally, you are in the Edit Assembly dialog box. This is where

you can modify existing wall types or create new ones. Click
<<Preview to display a preview of the selected wall type.
(Figure 3-2.5)

Edit Assembly

B

Family: Basic Wall
Type: Exterior - Brick on CMU
Total thickness: 1 717 Sample Height:
Layers
EXTERIOR. SIDE

E -

Functien

Material Thickness

-

Misc. Air Layers

1

2| Thermal/Air La 03

3 | Thermal/AirLa  Insulation / The :0' 3"

4 |Membranelay  Vapor/ Moistur (0" 0"
T [ Core Bounday  Layers Above We 0° 0"

[ 6 | Structure [1] Masonry - Con 0" 75/8"
7 | Core Boundary  Layers Below Wr 0" 0"
8 | Substrate [2] Metal - Furring 0" 15/8" i

INTERIOR SIDE

[ Insert ] [ Delete ] Up
Default Wrapping

At Inserts: At Ends:

[Do not wrap - ] [None - ]

Modify Vertical Structure (Section Preview only)

i Modify Merge Regions Sweeps
] (= r
Assj rs Split Region Reveals
o
\Cl A Wiew: [Floor Plan: Modify tyy v] [ Preview > [ Ok ] [ Cancel ] [ Help

]
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Figure 3-2.5 Edit Structure
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Here, the Edit Assembly dialog box allows you to change the
composition of an existing wall or (similar) to create a new wall.

Things to notice (Figure 3-2.5):

e The exterior side is labeled at the top and interior side at the
bottom.

e You will see horizontal lines (i.e., Core Boundary) identifying the
core material. The core material can be used to place walls and
dimension walls. For example: the Wall tool will let you draw a
wall with the interior or exterior core face as the reference line.
On an interior wall you would typically dimension to the face of
CMU rather than to the finished face of gypsum board. This is to
work out coursing and give the contractor the information
needed for the part of the wall he will build first.

e Each row is called a layer. By clicking on a layer and picking the
Up or Down buttons, you can reposition materials within the
wall assembly.

% 9. Click Cancel in each open dialog box to close them.

10. Set the Wall Style back to Basic Wall: Generic — 12" in the
Element Type Selector.

11. Click the Element Properties button next to the Element Type
Selector.
TIP: Click the down arrow and select Type Properties to skip the next step.

12. Click the EditType... button.
13. Click Duplicate.

14. Enter Brick & CMU cavity wall for the new wall type name,
and then click OK (Figure 3-2.6).

Mame [ih,l‘

MName: | Brick & CMU cavity wall

Figure 3-2.6 New wall type name

15. Click the Edit button next to the Structure parameter.

3-6
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Using the Insert button and the Up and Down buttons, add the
layers to your new wall style as shown below in Figure 3-2.7.

Function Material Thickness
Finish 1 [4] Masonry -Brick 4"
Thermal/Air Layer [3] | Misc. Air Layers — Air Space 2"
Thermal/Air Layer [3] | Insulation / Thermal Barriers - Rigid | 2"

Insulation
Core Boundary Layers above wrap 0”
Structure [1] Masonry — Concrete Masonry Units 8"
Core Boundary Layers below wrap 0”
Finish 2 [5] Metal - Stud Layer 22"
Finish 2 [5] Gypsum Wall Board "

Figure 3-2.7 New wall layers

Masonry is typically drawn nominally in plans and smaller scaled
details. This helps to figure out coursing for both drawing and
dimensioning. For example, 8" concrete block is actually 75s".

Also, notice that the CMU, Rigid Insulation, Air Space and Brick add up
to 16" in thickness. This portion of the wall would sit on a 16" concrete
block (CMU) foundation wall directly below.

16. Your dialog should look like Figure 3-2.8. Click OK to close all
dialog boxes.

Edit Assembly (S
L Famiy: Basic Wall
Type: Brick CMU cavity wall
Total thickness: 1 71/8" Sample Height: 20' 0"
Layers
EXTERIOR SIDE
Function Material o
J Finish 1 [4] Masonry - Brick .
2 | Thermal/Air Lay | Misc. Air Layers- AP 10" 2" v
3 | Structure [1] Insulation / Therma 0" 2" 7
4 | Core Boundary Layers Above Wrap - 0° 0"
O 5 | Structure [1] Masonry - Concrete 0" 8"
6 | Core Boundary Layers Below Wrap - 0" 0"
7 | Finish 2 [5] Metal - Stud Layer 021721 [F
& | Finish 2 [5] Gypsum Wall Board 0" 05/8: [ A
INTERICR SIDE
| Insert | | Delete | Up Down
Default Wrapping
At Inserts: At Ends:
‘Do not wrap v| |None v|
Modify Vertical Structure (Section Preview only)
] 3
o . :
9\ ‘ View: | Floor Plan: Modify typ v| ‘ Preview > | [ Ok ] | Cancel | | Help |

Figure 3-2.8 Edit Structure for new wall type
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The next step is to change the wall type for the walls previously
drawn.

17. Select the Modify button on the QAT; this allows you to select
objects in your drawing.

18. Zoom out so you can see the entire plan. Dragging your
mouse from one corner to the other, make a window over the
plan to select all the walls.

19. With the walls selected, pick Basic Wall: Brick & CMU cavity
wall from the Element Type Selector drop down.

TIP:

If, after selecting all the walls, the Element Type Selector is not active and does
not show any wall types, you probably have some other object selected like text or
dimensions. Try to find those objects and delete them (except the elevation tags).

You can also click on the Filter button (located on the Ribbon when objects are
selected) and uncheck the types of objects to exclude from the current selection.

You should notice the wall thickness change, but the wall cavity lines
and hatch are not showing yet. This is controlled by the Detail Level

option for each view. o | -
20. Click on Detail Level icon in the B Coarse
lower-left corner of the Drawing g N
. Fine
Window. 1/8" = 1'-0" F@-&-@m@@ g
21. Select Medium. Detail Level; Set to medium

You should now see the brick and CMU thicknesses with hatching. If
you did not pay attention when drawing the walls originally, some of
your walls may show the brick to the inside of the building.

22. Select Modify (or press Esc); select a wall. You will see a

symbol appear that allows you to flip the wall orientation by
clicking on that symbol (Figure 3-2.9).
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Click this symbol to
flip wall orientation

17 -4 778"

Figure 3-2.9 Selected Wall; notice some walls have the brick on the interior

23. Whether you need to adjust walls or not, click on the flip

symbol to experiment with its operation.
TIP: The Flip symbol is always on the exterior side (or what Revit thinks is
the exterior side) of the wall.

24. If some walls do need to be adjusted so the brick is to the
exterior, do it now. You will probably have to select the wall(s)
and use the Move tool to reposition the walls to match the
required dimensions.

TIP: If you set the “location line”, via Instance Properties, to Wall Centerline,
the wall will not move and mess up overall dimensions when flipping it. You
will want to set the “location line” back to Finish Face: Exterior when done.

25. Save your Project as ex3-2.rvt.

TIP:
.
+ *D'-h

You can use the MOVE tool &Y€ on the Ribbon (when a wall is selected) to
accurately move walls.

Follow these steps to move an object:
e Select the wall
Click the Move tool
Pick any point on the wall
Start your cursor in the desired direction (don't click)
Start typing the distance you want to move the wall and press Enter.
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Finally, you will change the three walls at the atrium to be curtain wall
(full glass). This will let lots of light into the atrium and better identify
the main entry of the building.

26. Drag a window (from left to right) to select the three walls
around the atrium.

27. With the walls highlighted, select Curtain Wall: Curtain
Wall 1 from the Element Type Selector drop-down.

Your atrium is now surrounded by curtain wall (Figure 3-2.10). In a
later lesson we will add horizontal and vertical mullions to the curtain
wall.

You can see your progress nicely with a 3D view. Click the 3D &
View button on the QAT. Notice that Revit shows the curtain

wall as transparent because it knows the curtain wall is glass. The
other walls are shaded on the exterior side to make the image read
better.

28. Save your project as ex3-2.rvt.

Revit automatically sets the hatch intensity and line weights.
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Interior walls

In this lesson you will draw the interior walls for the first floor.

Adjust wall settings: g

1. Select Home - Build - Wall from the Ribbon.

2. Make the following changes to the wall options on the Ribbon
and in the Options Bar (Figure 3-2.1):
e Wall style: Basic Wall: Interior — 4 7/8" partition (1-hr)
e Height: Level 2
e Location Line: Wall Centerline

Draw the interior walls:

3. Draw a “vertical” wall approximately as shown in Figure 3-3.1.
You will adjust its exact position in the step #4.

Step #4 (second click):

pick left side of this ~
wall

Step #4 (first click):
pick the edge of this

wall _ \

Figure 3-3.1 First interior wall

4. Select Modify > Edit > Align tool to align it with

the edge of the exterior wall in the atrium (Figure 3- D:
3.1). When you are done, the wall should look like Alian
Figure 3-3.2. e
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5. Create the same wall for the west side
of the atrium repeating the above
steps.

Modify an existing wall type:

Next you will add some additional interior
walls. You will be drawing 8” CMU walls. Revit
does have an 8" Masonry wall type available in
the default template file that you started your
project from. However, the thickness for this
wall type is 758", which is the actual size of a
block. Floor plans are usually drawn nominally
(i.e., 8”) not actual (738"). This is done so you
can figure out coursing so minimal cutting is
required. Therefore, rather than creating a new

wall type you can simply modify the existing
wall type. Figure 3-3.2 First interior wall

6. Select the wall style: Basic Wall: Generic — 8” Masonry.

7. Select Element Properties > Type Properties button, and
then click Edit next to the Structure parameter.

8. Change the masonry thickness from 753" to 8" in the edit
structure dialog box, and then select OK to close each dialog.

Occasionally Revit will not list dimensions, relative to the walls you
want to draw new walls from, while in the create wall mode. One way
to deal with this is to draw temporary Detail Lines to use as a
reference. After using the temporary wall as a reference you can
delete it.

9. Select Annotate -> Detail > Detail Line from the Ribbon; the
line type does not really matter, but select a continuous one.

10. Draw the “vertical” line shown in Figure 3-3.3; be sure to snap
to the Midpoint of the atrium wall as your first point.
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Next you will draw an elevator shaft, centered on the atrium and 35'-

0” back (thus the temporary line).

The inside dimensions of
the elevator are:

7'-4" x 6'-10". Because
you know the inside
dimension you will want
to adjust the location line
to match the known info.

11. Use the Wall tool
to draw Basic
Wall: Generic -
8" Masonry.

12. Set the Location
Line to: Finish

Face: Interior.

13. Draw the elevator
shaft. Make sure
the location line is
to the inside so
your shaft is the
correct dimension.
Draw the shaft
anywhere in the
drawing; you will
adjust the exact
position next.

FYI: The inside dimensions are listed above.

-0

as'

First pick, using
the midpoint snap

18 -0°

S

-

=

Figure 3-3.3
Temporary Detail Line

14. Select the 4 walls that represent the elevator shaft, and then

pick the Move tool.

TIP:

walls.

° eI_OII or el_8"

Dimension rules for CMU coursing in floor plans:
where e is any even number (e.g., 6’-0” or 24'-8")
e 0-4" where o0 is any odd number (e.g., 5'-4")

Concrete blocks come in various widths, and most are 16” long and 8” high. When
drawing plans there is a simple rule to keep in mind to make sure you are
designing wall to coursing. This applies to wall lengths and openings within CMU

3-13
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15. Snap to the Midpoint of the shaft as your first point, and then
snap to the Middle Endpoint of your temporary detail line
(Figure 3-3.4). You should zoom in to verify your snaps. Do not
draw the dimensions; they are for reference only.

The elevator shaft is now perfectly 71_ 4

centered in the atrium and exactly

35’-0” back from the south curtain wall.

16. At this point you can delete the

/IX

6'- 10"

temporary line. Select the line
and then right-click and select
delete (or press the Delete key
on the keyboard).

First pick, using
the midpoint snap

Second pick, snapping
to the middle of the
line’s end

Figure 3-3.4 Move elevator shaft into place

FYI:

verify that they are 36’-0” tall.

When a wall is selected, you can click the Element Properties button on the
Ribbon to see that wall’s properties. Click one of the elevator shaft walls and

Modify an existing wall:

Next we want to change the portion of wall between the building and
the east and west stair shafts. To do this you will need to split the
current wall, trim the corners and then draw an 8” masonry wall.

17. Zoom in on the west stair shaft and select the Split tool

(Modify tab on the Ribbon).

18. Pick somewhere in the middle of the wall (Figure 3-3.5).

19. Select Modify 2> Edit > Trim to trim the corners so the
exterior wall only occurs at exterior conditions (Figure 3-3.6).

TIP: Select the portion of wall you wish to retain.
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Additional custom wall types:

We decide that the stair shafts are mostly utilitarian and do not require
gypsum board on the walls. In the next steps you will create a new
exterior wall type just like the one previously created less the gypsum
board and metal studs. Also, you will create a custom wall type to
close the open side we created in the previous steps. This wall type
will have gypsum board and metal studs on one side.

20. Using wall type: Basic Wall: Brick & CMU cavity wall as a
starting point, create a new wall type named Brick & CMU
cavity wall (no GWB). Remove the gypsum board and metal
studs and save the new wall type. (Remember to click Duplicate.)

21. Change the three exterior walls around the west stair shaft to
the new wall type created in the previous step.
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22. Using wall type: Basic Wall: Brick & CMU cavity wall as a
starting point, create a new wall type named 8" Masonry with
GWB 1S. Remove the brick, air space and rigid insulation and
save the new wall type (Figure 3-3.7).

FYI: It will be useful to come up with a standard naming system for your
custom wall types. If the names get to long they are hard to read. The
example above has:

e GWB = Gypsum Wall Board (and would imply studs)

e 1S = finish only occurs on one side of the wall.

Function Material ' Thickness
n/a n/a n/a
Core Boundary | Layers above wrap 0”
Structure [1] Masonry - Concrete Masonry Units 8"
Core Boundary | Layers below wrap 0”
Finish 2 [5] Metal - Stud Layer 22"
Finish 2 [5] Gypsum Wall Board "

Figure 3-3.7 New wall layers

23. Draw a wall so the gypsum finish
continues on the office side, using the
Align tool if necessary (Figure 3-3.8). H
Use the Measure tool to make sure the stair
shaft is the correct size; don’t draw the
dimensions.

Next you will use the Mirror tool to update the
east stair, but first you will draw a Reference
Plane to use as the Axis of Reflection (more on
this later while using the Mirror tool).

19' - 4"

24. Select Home > Work Plane > o
Ref Plane from the Ribbon. ,  ®°°f

25. Draw a Reference Plane snapped to the
vertical, centered on the south atrium N
wall (See Figure 3-3.9).

26. Erase the four walls of the east stair H
shaft; this will include the main east wall
of the office building (Figure 3-3.9)

Figure 3-3.8 Revised west stair

27. Select the six walls at the west stair (Figure 3-3.9).

TIP: Make sure the count is correct on the Status Bar. ? 6
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28. Select the Mirror tool (on the Ribbon) and then
select the Reference Plane (Figure 3-3.9).

4

Dlﬁ] Mirror
¥

TIP: The Mirror tool only shows when something is selected.

Pick the
Reference
Plane as
the axis of
reflection

\

L

Figure 3-3.9 Mirror west stair

29. Use the Measure tool to verify the overall length of the
building is 140’-0”. Adjust as necessary (see Figure 3-2.2).

i

Figure 3-3.10 Mirrored west stair

Finally, you will draw a few more interior walls to compete the first
floor plan. Do not delete the Reference Plane.

NOTE: The reference line may not show up in every image in this text.
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30. Using the Wall tool, set the wall type to:
Basic Wall: Interior — 4 7 /8" partition (1-hr)

31. Draw the additional walls shown in Figure 3-3.11. Make sure to
position the walls per the dimensions shown. Use the Measure
tool to verify accuracy. Also, modify the Location Line as
required.

Drawing Tips: Copy the existing atrium wall 6’-478" over (6’-0" plus
one wall thickness), draw a wall from the midpoint of the elevator
shaft with centerline reference (Location Line), and use Trim and
Mirror tools. Do not draw the dimensions. SAVE YOUR PROJECT as
ex3-3.rvt.

CLEAR

CLEAR CLEAR

19'- 0"
CLEAR

Figure 3-3.11 Remaining interior walls
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Exercise 3-4:

Elevator

This lesson will show you how to insert an elevator into your elevator
shaft.

Insert elevator:

Revit provides many Families, which are packages of predefined
objects ready to insert into your project. However, many objects are
not readily available, like elevators for example. You will get an
elevator family online in this exercise. The online library is where you
will acquire an elevator family for use in your project.

1. Open project ex3-3.rvt and Save As ex3-4.rvt.

2. Open your web browser (e.g., MS Internet Explorer).

You will have to download the elevator from the web. Of course you
will need to be connected to the Internet.

3. Browse to the following internet address:
http://revit.autodesk.com/library/html/index.html.

4. Click Archived Libraries and then Revit 2009 Libraries.

& Revit 2010 Content Distribution Center - Microsoft Internet Explorer = | B o o) NO TE: ThIS /eSSOI’I WI// use
;@(.::E; \‘,Lr::::emaumdeskwm/hbrayy/htmvmdahw <[] % | Googte — i‘v archl'ved Content from the

:0 gle| 8~ B [] searcn { - - | B - ¥ Bookmarks~ | G, Find - P Check - > ;“\\v edam;\m' 2009 /lbl’ary as the SpeCIﬁC
% @ |@) Revit 2010 Content Distribution Center % v B v @ v [ Page v G Tooks v I'tems needed here are nOt

Autodesk’  sournice " on Autodesk’s new content

g site (seek.autodesk.com).
Revit can always read older
Revit project and content
files, even though there is
no support for the reverse.
This means you cannot
work on Revit 2010 at
home and then open the file
in Revit 2009 at work; and
there is no Save-As
command either!

Autodesk Seek
Shared Content and Revit
ibrarie: US_Canada and

the UK

Revit Architecture 2010
Library

FRA Library
Revit Structure 2010 Library

Modern Medium 2010
Library

Revit Instruction & Help
Samples

Archived Libraries

eit 9 Libr
e ries
Revit 2000 Libraries «
Please Not

Contact Us! All 2010 English content is now being hosted on Seek

This site requires Intemet Explorer 5+ or Netscape Navigator 6+.

Autodesk Seek
Architecture 2010 Structure 2010 utodesk See

B € Internet | Protected Mode: Off 100% v

Figure 3-4.1 Web content via browser
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A new browser/tab will open and
you will be looking at the
contents of Revit's Content
Distribution Center

( Revit 2009 Content Distribution Center - Microsoft Internet Explorer,

GO - Mmooty
@ - @ BB

W | Revie 2009 Cortent Disrbuton Center [ %5 - B - @ - [ rage - {Tooks -

Autodesk

show/hide:

(Figure 3-4.2).

5. Click on the link:

“Revit Architecture

2009 Library”.

Revit Architecture 2009
Library

FRA Library
UK Library
= US Library
[E] Families
Annotations
Balusters
Casework
Columns
Curtain Wall Panels
Detail Components

Furniture System
Lighting Fixtures

Mass

Mechanical Equipment

Misc. Architectural

Doors 1
Electrical Fixtures :
Entourage 1 L ¥
Furniture : =
1
1
1

Revit Architecture 2009
Library

Revit MEP 2009 Library
Revit Structure 2009 Library
Revit Manufacturer 2009
Library

Modern Medium 2009
Library

Revit Instruction & Help
Samples

Archived Libraries

Autodesk Seek (Content
Search)

Contact Us!

This site requires Internet Explorer 5+ or Nets:

Architecture 2009 Structure 2009 MEP 2009

@ irternet

oo -

Figure 3-4.2 Web content via browser

Click the plus next to US Library,

Families, Specialty Equipment, and
then select Conveying Systems (Figure

3-4.3).

Within the web browser you should see a graphical
representation of each family available for download
(Figure 3-4.4).

Escalator

Figure 3-4.4 Web content visuals

Planting 7. Click “Elevator-Electric” to download that
Plumbing Fixtures fam||y
Profiles
ste 8. Select Save (Figure 3-4.5a).
& specialty Equipment
Church
Classroom-Library e —— %
Conveying Systems
Domestic Do you want to open or save this file?
Exercise Equipment [y MName: Elevator-Electric.ifa
Fire Protection S
Food Service
Lab Open | [ Save | [ Cancel
I adders ] Aiways ask before opening this type of file
Figure 3-4.3 _ | QI Vibie e o th et can be ssil,some lescan petentaly
Web content categories e titie Wnasthonc?

Figure 3-4.5a Web browser prompt
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9. Save the file to the Desktop using the default name provided.

Now that you have saved the elevator family file to the hard drive, you
need to load it into your current project.

oad
Family
11. Browse to the Desktop and select the Elevator-Electric.RFA,
and then click Open.

10. Select Insert > Load from Library > Load Family
from the Ribbon.

12. In the Project Browser, click the E'"____Tm'“tej N
plus next to Families to expand the = = C;ﬁ;;ﬁ'm ymhers
list (Figure 3-4.5b). =+ S —

13. Expand the Specialty Equipment @ B~ Curtain Fanels
list, and then Elevator-Electric. @ @ &~ Curtain Wall bMullions
(Figure 3-4.5p) . H- Detail kems

---- Dooars
As you can see, four elevator types were | B Floors
loaded into your project. Similar to wall | &~ Furniture
types, you can add one of these types as- | &E- Parking
is, or you can modify or create a new type. | &~ Flanting
Next, you will add information in the Type @ & Frofiles
Properties dialog to better documentthe | - Failings
elevator specified. | @~ Famps

---- Foofs

14. Right-click on the elevator type: - Specialty Equipment
2000 Ibs, and then select B Elevator-Electric
Properties from the pop-up menu. - 2000 Ibs

- 2500 |hs

You will now see a listing of the properties - 3000 |bs

for the selected elevator type. L 3E00 Ihs
B Stairs

Figure 3-4.5b Elevator library:
Project Browser
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15. Click the Preview button (if necessary) to see the graphical
review of the elevator type. Set the View to 3D View: View 1.

16. Add the following information (Figure 3-4.6):

e Model: MadeUp 8864
e Manufacturer: ThyssenKrupp Elevator
e URL: www.thyssenelevator.com

The three entries in step 16 are optional (although not for this
exercise), but this is a great way to better document the project. This
is part of the I in BIM (Building Information Modeling).

Type Properties @
- Family: [Eevamr—lﬂectric hd ] Load...

Type: (2000 Ibs v| | Dulcate... |

Rename...

Parameter Value | -

Identity Data A
Keynote
Madel Madelp 8864

Manufacturer ThyssenKrupp Elevator

Type Parameters

Type Comments www.thyssenelevator.com
URL

Description

m

Assembly Description

Assembly Code
Type Mark

Cost

OmniClass Mumber

OmniClass Title
Other
Width
Pit Depth
[| Door Opening
- Depth
] 3 Cab Width

>3

Thihi il
L=

View: [30 View: View 1 v] [ Preview == l ’ Ok ] ’ Cancel Apply

Figure 3-4.6 Elevator properties

17. Click OK to close the open dialog box.
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18. Drag the 2000 Ibs elevator type from the project browser into
the first floor plan.

The elevator type will be attached to you cursor, ready for insertion.

19. Move your cursor within the elevator shaft and adjust it until
the elevator “snaps” in place; then click.

20. Press Esc twice to tell Revit you are finished placing elevators.

Now you have to add an elevator door in the shaft walls; this is similar
to a regular door in a wall. Like the elevator, the elevator door has to
be downloaded from the internet. You will do that next.

21. Similar to the steps previously covered, load the Elevator
Door - Center family from the Web Library (Figure 3-4.7).

(& Revit 2008 Content Distribution Center - Micrasoft Internet Explorer E=SEE =
@\/ - [ ] nttpy//revit autodesk.comylibrary/archive2008/htmlfindex html [ 43 x ][ Googte 2 |
& Convert v [ Select (&2 snagit B 1

Google 8- [+] searen { [ R | B - 1% Bookmarks- ‘ |G Find + % Check = ® <+ @ daniel..~
%% 4 | @ Revit 2009 Content Distribution Center M ov B v @ v [>Page v @ Tooks ¥

AutOdesk show/hide: download directory-------- > @

Revit Architecture 2009

Library D
FRA Library

]
UOC
0
HOC_
O

1
100

UK Library 1
3 uUs Library
= Families I:l
Annotations Double-Panel 1.Dbl Acting Double-Panel 1 Double Panel1 notrim  Double Panel 2.Dbl
Balusters Acting
Casework
Columns —=>
Curtain Wall Panels |:||:| [”:| ]D D[ ool
Detail Components H
s juu s
Electrical Fidures i
Entourage D[I [”:I DD DD l:l E DD DD U
Furniture
Furniture System Double-Panpal 2 Dauhla Panel 2 no trim Double-Pocket Double-Raised Panel with
Lighting Fixtures Double-Panel 2.rfa | Sidelights
Mass
Mechanical Equipment
Misc. Architectural
Planting \
Plumbing Fixtures *
Profiles
Site
[ Specialty Equipment
Church Double-Uneven Double-Uneven no trim Elevator Door-Center Elevator Door-Side

Classroom-Library

Conveying Systems

Domestic

Exercise Equipment
Fire Protection
Food Service

Architecture 2009 Structure 2009

http://revit.autodesk.com/library/archive2009/Library/Revit%20Archite ¥ € Internet | Protected Mode: Off ®100% ~

Figure 3-4.7 Elevator door in Revit Web Library
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22. Drag the 36" x 84" elevator door @& Foofs
type from the project browser into - Specialty Equipment
the first floor plan (Figure 3-4.8a). E """ Elewvator Door-Center

3Dy B4
23. Place the elevator door at the center :

.m4

of the wall, aligned with the elevator 2" % 84"
door on the cab (Figure 3-4.8b). L 48" x 84
PR 900 % 2100rmm
- N i
TIP: If the door is inserted on the wrong I?_!_?;SE?;E;H”C
side of the wall, select the door and click the @ ———
Control Arrows to flip it within the wall. s
....... 3DDD|bS
....... 35DD|bS
- Stairs

F- Structural Columns

Figure 3-4.8a Elevator doors in
Project Browser

XX X X K X

Figure 3-4.8b Elevator door added to plan

Notice when the elevator is selected, the Flip icon (control arrow) is
displayed. Similar to the doors and walls, you can click this icon to flip
the orientation of the elevator within the shaft.

24. Save your project as ex3-4.rvt.
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Doors and Windows

This lesson will take a closer look at inserting doors and windows.

Insert doors: %

Revit has done an excellent job providing several different door
libraries. This makes sense seeing as doors are an important part of an
architectural project. Some of the provided libraries include bi-fold,
double, pocket, sectional (garage), and vertical rolling, to name a few.
In addition to the library groups found on your local hard drive, many
more are available via the Web Library feature.

The default template you started with only provides the Sgl Flush
(Single Flush) group in the Doors category. If you want to insert other
styles you will need to load them from the library. The reason for this
step is that, when you load a library, Revit actually copies the data
into your project file. If every possible group was loaded into your
project at the beginning, not only would it be hard to find what you
want in a large list of doors, but also the files would be several
megabytes in size before you even drew the first wall.

You will begin this section by loading a few additional groups into your
project.

1. Open project ex3-4.rvt and Save-As ex3-5.rvt.

2. With the Door tool selected, select the Load Family button on
the Ribbon (Figure 3-5.1).

3. Browse through the Imperial Library folder for a moment.

Autodesk Revit Architecture 2010 - [Ex3-4.nvt - Flca
% O Single-Flush Cf::' E i
= 36" x 84
Maodify Element - J| Model Load
e - Change Element Type i e
Selection Element Maodel

Place Door | Tag on Placement IE', Horizontal = | Tags. Leader Attached End H 1/2 i
Ba-4.nt - Projectb... (5] || - st A e A ;

Figure 3-5.1 Load Family
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Each file represents a Family; next you will load four door Families into
your project (Figure 3-5.2).

[ R | Load Family @Ii:_hj‘
Look in: | Doars v| b= ¥ BY vews ~
- Preview
L-' # | Name Date modified Type =
= Bifold-2 Panel.rfa 3/16/2009 10:37 PM  Revit Family
Bifold-4 Panel.rfa 3/16/2009 10:37 PM  Revit Family
Curtain Wall Dbl Glass.rfa 3/16/2009 10:37 PM  Revit Family =
- j? Curtain Wall 5gl Glass.rfa 3/16/2009 10:37 PM  Revit Family L
Curtain Wall-Store Front-Dbl.rfa  3/16/2009 10:37 PM  Revit Family
1 Double-Flush.rfa 3/16/2009 10:37 PM  Revit Family
[I: Double-Flush-Dbl Acting.rfa 3/16/2009 10:37 PM  Revit Family
= Double-Glass 1.rfa 3/16/2009 10:37 PM  Revit Family
Double-Glass 2.rfa 3/16/2009 10:37 PM  Revit Family
!E} Double-Panel 1.fa 3/16/2009 10:37 PM  Revit Family
. Double-Panel 2.fa 3/16/2009 10:37 PM  Revit Family
Double-Uneven.rfa 3/16/2009 10:37 PM  Revit Family
! Opening-Cased.rfa 3/16/2009 10:37 PM  Revit Family
Opening-Elliptical Arch.rfa 3/16/2009 10:37 PM  Revit Family
Overhead-Rolling.rfa 3/16/2000 10:37 PM  Revit Family -
4 n 3
|-
File name:  Curtain Wall Dbl Glass.rfa -
~ | Files of type: |NI Supported Files (*.rfa, *.adsk) N ‘
Tools - | Open | | Cancel
\

Figure 3-5.2 Door groups on hard drive
4. Select Curtain Wall Dbl Glass.rfa, and then click Open.
(Figure 3-5.2)

5. Repeat steps 2 - 4 to load the following door groups:
a. Double-Glass 1

b. Sidelights 1 - 8 Famiies
c. Single-Glass 1 + Annotation Symbols
+ Ceilings
6. In the Project Browser, expand +- Calumng
Families and Doors to see the +- Curtain Panels
loaded door groups (Figure 3-5.3). * Curtain Y all Mullions
+- Detail ltems
If you expand the door header itself in T E':":"S
X Double-Glass 1
the Project Browser you see the +- 5gl Flush
predefined door sizes associated with that 3 Single-Glass 1
category. Right-clicking on a door size + Floors

allows you to rename, delete or duplicate
it. To add a door size you duplicate and
then modify properties for the new item.

Figure 3-5.3 Loaded door groups

Next you will insert the doors into the stair shafts.
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Office Building: FLOOR PLAN (First Floor)

With the Door tool selected, pick Sgl Flush: 36" x 84" from
the Element Type Selector on the Ribbon.

Insert two doors in the west stair shaft as shown in Figure 3-
5.4. Remember you are inserting a door into a masonry wall so
your door position and size need to work with coursing. Thus
the 8” dimension.

Repeat the previous step to insert doors into the east stair
shaft.

Finish inserting doors for the first floor (Figure 3-5.5).
Use the following guidelines:

a. All doors should be 36" wide and 7'-0" tall.

b. You will not insert doors into the curtain wall for now. You
will do that in a later lesson when you design the curtain
wall.

c. Use the style and approximate location shown in Figure 3-
5.5.

d. Doors across from each other in the two atrium walls

should align with each other.
TIP: While inserting the second set of doors, watch/wait for the
reference line to show up, indicating alignment.

e. Place doors approximately as shown, exact location not
given.

Figure 3-5.4 Door in west stair shaft
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Figure 3-5.6 Door properties
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v AN
Single-g| ﬂ
ingle-glass 1 i -
gle-g \@ 5\ [ Single-glass 1
Sgl. Flush
10 "
[
H K
@
Double-glass 1 — @ «—1 Double-glass 1
[ 3)
@
%
Figure 3-5.5 First floor with doors
Type Properties o] .
S — .= || | Door Properties:
[ o) [omeen ) If you select Type
" Rewme.. Properties while the Door
e — - tool is active (selected),
Cortracton you can modify various
ComsetonTipe e properties related to the
Function Interior
Materials and Finishes door'
Door Material i Deor - Panel
Frame Material i Door - Frame .
Dimensions You can easily add another
o e standard door size to the
T braesion s yr Family as required. Click
ke S5 “Duplicate,” type a name
o e (Figure 3-5.6).
- M@Mﬂ H
‘ | | - - Standard doors sizes (and
view: | 30 View: View 1 - | Preview > | [ oK ]| Cancel Famllles) Ccan be added to

your template file, so you
don’t have to re-load them
for every new project.
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Insert windows:

Adding windows to your project is very similar to adding doors. Like
the doors, the template file you started from has one family preloaded
into your project, the FIXED group. Looking at the Element Type
Selector drop-down you will see the various sizes available for
insertion. At this point you should also see the SIDELIGHT group that
you loaded in the previous exercise. First, you will add a few interior
borrowed lights using the sidelight family.

Interior windows (borrowed lights):

11. With the Window tool
selected, pick:
Sidelights 1 : 18" x 84"
from the Element Type
Selector.

12. On the west side of the
atrium, insert the
borrowed lights as
shown in Figure 3-5.7;
do not draw the
dimensions.

Make sure the borrowed light
frames are flush with the
atrium side of the wall. You can
control that option by moving
your cursor to the side of the
wall you want the frame flush
with before clicking to insert.
After drawing the window, you
can select the frame and use
the flip icon (similar to doors Figure 3-5.7 Sidelights added
and walls).

13. Repeat the previous steps to insert the borrowed lights on the
east side of the atrium.
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Exterior windows:

14. Using the methods previously covered in this book, create a
new window size in the FIXED family. Create: Fixed: 32" x
48". You are creating this new size to fit coursing in plan view.
The largest window (preloaded) that fits coursing in plan view is
24", TIP: Watch the video V3-F if you need help!

15. Adjust the sill height for your new window size to fit within
coursing as well. Set the sill height for Fixed: 32" x 48" to be
3'-4" (Figure 3-5.8).

r 5
Type Properties @
- Family: lFixed V] Load...
Type: IEZ')( 48" v] I Duplicate... I
Rename...
Type Parameters
Parameter | Value | -
Construction 2
Wall Closure {By host |
Construction Type
Materials and Finishes H
Glass Pane Material  Glass |
Sash Material Sash 3
Dimensions H
Height 40"
Default Sill Height 34
Width 2'8"
Window Inset 0" 034"
L 1
Rough Width
Rough Height
Identity Data H
Assembly Code B2020100
Keynote
Model
i Manufacturer
‘ E Tvoe Comments o2
@ View: | 3D View: View 1 v] I Preview =3 I [ QK l I Cancel I
\

Figure 3-5.8 Added window size

16. Insert the window as shown in Figure 3-5.9. The window
should be inserted in masonry coursing.

NOTE: The dimensions displayed while inserting the window will not work as
displayed for coursing because Revit is measuring from the center of the
adjacent exterior wall. Thus, you will have to insert the window as close as
possible and adjust its location, verifying with the Measure tool.
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Array window: /jﬂ /ﬂ
The Array tool allows you to 7
quickly copy several objects that @ D

have the same distance between
them. You will use Array to copy
the windows:

17.
18.
19.

20.

21.

Click the Modify tool and then
select your window.

With the window selected, pick the
Array tool from the Ribbon.

In the Options Bar, type 6 for the
Number field (Figure 3-5.10).

Click the left mouse button at
the midpoint of the window and

move your mouse to the east until 34|
the dimension displayed is 8'-6".

Figure 3-5.9 Exterior window

You should now see the windows arrayed in the wall. 8’-6" is
not coursing, so select the Activate Dimensions button on the
Options Bar and then enter 8'-8" in the displayed dimension to
adjust the window openings. This allows you to more accurately
adjust the dimensions.

Figure 3-5.10 Window to be arrayed

1

Figure 3-5.11 Window after array
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22. Set the windows up on the three remaining walls of the first
floor (Figure 3-5.12). Consider the following:

a. This would be a good use for the Mirror tool.

b. If you need to create a temporary wall for a mirror
reflection axis, make sure the temporary wall is set to
centerline.

C. You can use the Reference Plane to mirror the windows in
the east west direction.

d. Use the Measure tool to verify accuracy.

e. Use the Ctrl key to select multiple windows.

1 ™
e BT ] ey o] [ 351 ¥ ¢ EB o I e T e |
a
»
(o Sy
=
]

Figure 3-5.12 Completed window layout

Cleaning house: - Windows

. . . . =l Fimed
As previously mentioned, you can view the various

Families and Types loaded into your project. The more 15“ § 24“
Families and Types you have loaded the larger your file is, 15“ "‘ 48“
whether or not you are using them in your project. 18" % 72
Therefore, it is a good idea to get rid of any door, window, 24" 24"
etc., that you know you will not need in the current 24w 48"
project. 24" w72

32" w 4"

B" = 24"

+- Sidelights 1

Figure 3-5.13 Project Browser

23. In the Project Browser, navigate to Families > Windows >
Fixed. Right click on 36" x 48" and select Delete.
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Self-Exam:
The following questions can be used as a way to check your knowledge of this
lesson. The answers can be found at the bottom of this page.

1.

The Options Bar allows you to set the height of a wall when first drawing it.

(T/F)

It is not possible to draw a wall with the interior or exterior face of the core
as the reference point. (T/F)

Objects cannot be moved accurately with the Move tool. (T/F)

The tool, in the QAT, has to be selected in order to select an
object in your project.

A wall has to be to see its flip icons.

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

1.

2.

10.

Revit comes with many predefined doors and windows. (T/F)

The length 3'-8" is a masonry dimension. (T/F)

You can delete unused families and types in the Project Browser. (T/F)
It is not possible to load families and types from the Internet. (T/F)

It is not possible to select which side of the wall a window should be on
while you are inserting the window. (T/F)

What tool will break a wall into two smaller pieces?

The tool allows you to match the surface of two adjacent
walls.
Occasionally you have to draw lines to use as a reference point

for another object or as a reflection mirror.

You can use the tool to copy an object multiple times in
one step.
The file has a few doors, windows and walls preloaded in it.

Self-Exam Answers:
1-T,2-F, 3-F, 4-Modify, 5 — Selected

3-33





